
	User guidance
The standard form following is for the preparation of a tender document for Consultancy Services: Single invited quotation
Guide notes
This standard form contains guidance in hidden text, ie:
GUIDE NOTES;
Guide Note examples
Viewing guide notes
1. If the guide notes are not visible, click on the Show/Hide button [image: image1.bmp].
2. If still not visible, then:

•  At the Tools menu;

•  Click Options, and click the View tab;
•  Tick the Hidden Text check box and click the OK button.
Insertion points
Each ‘»’ shows where input is required. Click onto each ‘»’ and overtype.
When completed
1. Remove all guide notes manually or by the following steps:
•  On the Edit menu click Replace, then (if required) 
•  Click the More button;
•  Click the Format button, click on Font;
•  Tick the Hidden check box and click the OK button;
•  Click the Special button, click on Any Character; then
•  Click the Replace All button.
2. Delete this User guidance, along with the following Page Break.
 


REQUEST FOR TENDER

WHEN COMPLETED, ATTACH THE FOLLOWING document TO A FACSIMILE, LETTER, OR EMAIL 

DO NOT COMBINE ELECTRONIC DOCUMENTS BECAUSE THIS WILL CORRUPT STYLES

insert: Name of project and/or contract, eg airds high school

for:

Insert the Name of project and/or contract, and description of services., For Example:

Extensions to Hopetown Public School

Architectural Design Services

»

Insert RFT number

NOTE: The contract, or Request for Tender (RFT), number must be allocated by the Suppliers Systems Coordinator.  To request one, use the form Request for list of pre-qualified consultants and RFT number.

RFT No: »

Insert the month and year.

»

Insert client’s name, For Example:  

Department of Education and Training

Client: »

Tender documents prepared by:

Insert the Agency name and Division/Group preparing the documents. For Example:

Department of Services, Technology & Administration
Programs Branch

»

Submission details:

Refer to Conditions of Tendering clause Submission of Tenders.

insert: description of services, eg design of gymnasium

insert: rft/Contract number

You are invited to submit a tender for the services described in ‘The Services’ below.

‘The Project’ section following is Optional. delete if not used. clauses will renumber

2 The Project

Give a brief description of the project and how the services under this proposed Agreement will fit in

2.1 The Project

»

Conditions of Tendering:

2.2 Conditions of Tendering

INSERT FACSIMILE NUMBER and the Date and time for reply

.1 Include the following details on the Tender Form and send your tender to facsimile number »  by » .

.1 The legal name under which you tender and the ABN.

.2 The name and contact details of the Consultant’s representative.

use OPTION 1 if a fixed lump sum fee is required.

use OPTION 2 if payment will be on a time basis. 

clauses will renumber

Option 1

.3 The lump sum fee for the services.

Option 2

.4 The estimated fee, personnel and their hourly rates. 

Delete the following  if not required

.5 Estimates of reimbursable expenses not included in the fee. (Identify the items)

.2 Fees, rates and other amounts in this tender must include GST if it is payable.

.3 Advise if you will not be registered for GST if the Agreement is entered into.

2.3 Disclosure of tendering and contract information

.4 The Principal will publish details of tenders and any contract awarded as a result of this tender process in accordance with the Government Information (Public Access) Act 2009 (NSW) and Premier’s Memorandum 2007.
Conditions of Agreement:

2.4 General conditions

Insert the name of the entity that will be responsible for making payments to the consultant, eg. ‘the Minister for XXXX for the State of New South Wales’, or the name of the statutory corporation 

.5 The Principal under this Agreement will be the » . 

Insert either a specific number and ‘weeks of acceptance of tender’, or ‘the number of weeks stated in the tender’

.6 The Services are to be completed within ».

.7 The Consultant must maintain the following insurance policies:

.1 professional indemnity insurance with a minimum indemnity limit of $250,000;

.2 public liability insurance in the joint names of the Consultant and the Principal for at least $5,000,000.  Note that it is adequate if you hold an annual policy that covers the Principal in general terms (not necessarily naming Principal);

.3 insurance covering Workers' Compensation and related liability in accordance with the requirements of the Workers' Compensation Act 1987 (NSW).

.8 Title to and intellectual property in or in relation to the work under the Agreement vests in the Principal upon its creation.

.9 The Agreement may be terminated at any time. The Consultant will be paid reasonable costs incurred prior to termination.

2.5 Protection of children and other vulnerable people

Delete this set of clauses and above heading unless children or other vulnerable people are cared for on a site where services under the Agreement are to be carried out eg: existing school site. 

Employees

.10 The Consultant must not employ or permit to be employed on services under the Agreement at the site or sites a person who has been convicted of a serious sex offence and is a prohibited person under the Commission for Children and Young People Act 1998 (NSW).

Code of behaviour

.11 The Consultant must ensure that all persons performing services on the site or sites under the Agreement, including but not limited to your employees and managers, subconsultants and suppliers (Consultant Employees) understand and comply with the requirements shown below:

.1 All Consultant Employees who visit the site must complete a Prohibited Employment Declaration (available on the Internet at www.kids.nsw.gov.au) before entering the site.  The Consultant must maintain records of compliance with this requirement.

.2 All Consultant Employees must gain permission to enter the school or facility before performing related services and they may only enter approved areas.  Your representative, or a subconsultant’s representative performing services without your supervision, must report their presence to the person in charge of the school or facility on arrival each day and record, in the Site Visit Log, the details of all Consultant Employees performing services at the site or sites that day.

.3 Consultant Employees should avoid talking with, touching or interacting with any children or residents or other users of the school or facility except where required to perform the services or in an emergency or safety situation.

.4 Consultant Employees must only use approved toilets and other facilities, unless the person in charge of the school or facility gives written authority to use alternative arrangements.

.5 Appropriate privacy must be maintained when performing services on toilets and similar facilities.  Consultant Employees must ensure that toilets and similar facilities are not occupied or in use by children, residents or other users before entering to perform work, and that performance of services does not continue when use of the facilities is required.  Where practicable male employees should perform services on male facilities and female employees on female facilities.

.6 Consultant Employees should report any concerns about children’s behaviour or child abuse to the person in charge of the school or facility.

.7 Consultant Employees must wear or carry an identity card at all times when on the site or sites.

End of set of clauses: Protection of Children and Other Vulnerable People

2.6 Payment

.12 Payment of the fee will be on the basis accepted by the Principal.

.13 Reimbursable expenses will be reimbursed at cost. 

If possible, insert ‘on submission of <insert specific deliverables>‘ Otherwise, insert ‘on completion of the Agreement’

.14 The Consultant must lodge a payment claim »  .

.15 All payment claims must be accompanied by:

.1 a signed and completed ‘Subcontractor's Statement regarding Workers Compensation, Pay-roll Tax and Remuneration’ (Subcontractor’s Statement). For the purposes of the Subcontractor’s Statement you may be both a ‘subcontractor’ (to the Principal) and a ‘principal contractor’ (to your subcontractors, including suppliers and subconsultants). The form may be downloaded from the Office of State Revenue website at:

www.osr.nsw.gov.au/lib/doc/forms/opt011.pdf;
.2 a Workers Compensation Insurance Certificate of Currency unless the Consultant is a sole trader or partnership with no employees.  

.16 Within 10 Business Days (a Business Day is any day other than a Saturday, Sunday, public holiday or 27, 28, 29, 30 or 31 December) of the payment claim being received, the Consultant will be provided with a payment schedule stating the payment, if any, which the Principal will be making. Reasons will be given if the amount is less than that claimed. 

.17 The Consultant will be paid within 20 Business Days of the payment claim being received, subject to receipt of the Subcontractor's Statement and the Certificate of Currency. 

Check with the proposed Principal that the following gst Clause  is applicable. Amend if and as required.

.18 If the Consultant is registered for GST: 

.1 the Principal will issue payment schedules in the form of Recipient Created Tax Invoices, and Adjustment Notes in respect of adjustment events known to the Principal; 

.2 the Consultant must notify the Principal:

(a) of details of any adjustment event not known to the Principal, 

(b) if the Consultant ceases to be registered for GST,

(c) if the Consultant ceases to satisfy any requirements for the issue of Recipient Created Tax Invoices.

.19 If the Consultant is not registered for GST, the Principal will withhold tax from payments in accordance with the A New Tax System (Pay As You Go) Act 1999 (Cwlth). 

2.7 Payment claims for lump sum items

Delete this clause and the above heading if the department of Services, Technology & Administation will not be processing contract payments through the Opws management system.
.20 A claim for payment of any proportion of a lump sum, including any lump sum in a Schedule of Rates or Schedule of Prices, must be expressed as a percentage.
End of clause – Payment claims for lump sum items.
2.8 Communication

.21 The parties agree and consent that notices and communications may be by electronic communication in accordance with the Electronic Transactions Act 2000 (NSW).

2.9 Locating Existing Services

Include this clause and the above heading if the engagement requires the consultant to carry out excavation work, Otherwise Delete.

.22 The Consultant is responsible for locating services. 

.23 Before commencing excavation the Consultant must obtain, from the Dial Before You Dig information service or relevant public authorities or owners of underground services, written confirmation of the exact positions of all underground services at and around the Site, and verify and prominently mark the locations of the underground services on the Site. 

end of clause – locating existing services

3 The Services:

3.1 The Services:

Give details of services required, including technical requirements.   Attach drawings, etc., as required.
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4 Tender Form

Tenderer’s details

	Name:
(in block letters)
	………………………………………………………….…………

……………………………………………………….……………

ABN ...………………….…………………………….….……….

	
	

	Address:
	……………………………………………………….……………

………………………………………………………….…………

	
	

	Telephone number:
	……………………………………………………………….……

	Facsimile number:
	……………………………………………………….……………

	e-mail address:
	………………………………………………………….…………

	
	

	
	hereby tender(s) to perform the services for


Tender details

Ensure that the details match the agreement name and number used on the title page.

	Agreement name:
	» 

	RFT number:
	»

	
	in accordance with this RFT document

	
	and Addenda Numbers: …………………………………….……


use Option 1 or 2 and delete the option not used.

· Use Option 1 when the fee will be a lump sum.

· Use Option 2 when an estimated fee will be used.

Option 1

	For the Fee, being the lump sum of:

	…………………………………………………………………………………………….

	…………………………………………………………………………………………….

	($……………………………………………) including GST.


End of Option 1

Option 2

	For the estimated Fee, personnel and their hourly rates, being the sum of:

	Personnel
	Hourly Rate ($)
	Estimated
No of Hours
	Estimated fee ($)

	1. …………………………………….
	………….
	……………..
	…………….

	2. ……………………………………
	………….
	……………..
	…………….

	3. ……………………………………
	………….
	……………..
	…………….

	4. ……………………………………
	………….
	……………..
	…………….


Add Rows to table, if required

	up to the maximum amount of:

	…………………………………………………………………………………………….

	…………………………………………………………………………………………….

	($……………………………………………) including GST.


End of Option 2

Consultant’s representative

	Name:
(in block letters)
	………………………………………………………….………….

	
	

	Address:
	……………………………………………………….……………

………………………………………………………….…………

	
	

	Telephone number:
	……………………………………………………………….……

	Facsimile number:
	……………………………………………………….……………

	e-mail address:
	………………………………………………………….…………


Delete Reimbursable expenses table when Conditions of Tendering  clause 2.1.5 has been deleted.

Reimbursable expenses

	Item
	Estimated cost ($)

	………………………………………………………….
	………………………………

	………………………………………………………….
	………………………………

	………………………………………………………….
	………………………………

	………………………………………………………….
	………………………………


Authorised for the Tenderer by:
	Name:
	……………………………………………

	Position:
	……………………………………………

	Signature:
	……………………………………………

	Date:
	……………………………………………


Consultancy Services standard form contract document – Single invited quotation
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